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i Untitled Workspacei [=| .3

Cther Files

K12 DiH %

FE P AT LAAS B b AN [ 43 SCAE ) “ Add Files”  CARINSCAE) RIS, X 630 Ja s
AR R S0, 2l A R . FIRE IR P mT AP e 5 9 SCA B AR T AR B S e
SRMMBR SO, AEMNBR T RS 2 B4 F P 5 ZE A IR LS AN PRI H R AAE A .

§ 3.4 {ii FHICD23EAT Mk
§ 3.4 1 EHE R D BR

T8 58 BT PR BB N IR B R 2 5, FH P st el AT T
§3.4.1.1 %

{4 3% 9 Debugger->Connect, LA I T FLES 1 IybebE b oAee e, e Bemesh 2
1E “Output” % ) “MPLAB ICD2” {5 & 71 UK 278 “Target Device **** found, revision=**",
WE1B3HTR, WHEEER “ICDWarn0020:Invaild target device id . . 7 AB-A 1R A FYE B & LA 6.0
FL A PR I O

CEETE——— =loix|
Build I Version Control I Find in Files MFLAE ICD 2 I
Connecting to MPLAE ICD 2
ICDO019: Failed to open communicationz: Non—existent port
ICD0021: Unable to comnect with MPLAE ICD 2
ICDO021: Unable to comnect with MPLAE ICD 2
MFLAE ICD 2 Ready
ICDWarn0034: Pleaze ensure that wour system’ = serial FIFD buffers are disabled
Connecting to MPLAE ICD 2
v Connected
Setting Vdd source to MPLAE ICD 2
Tarzet Dewvice PICIEFETTA found, rewizion = b3
...Reading ICD Product ID
Funning ICD Self Test

... Passed
MFLAE ICD 2 Ready

P13 32 A A B
§3.4.1.2 4wi¥
B ROk P B AT gn i, DU AR sAH N R AR SCPE o s o 32 32 FL I Project->Build AR 4 1%
FEATH, s TR R E bR
i IR 45 BB AR “Output” % 1Y “Build” Tz, WURGNIPERIL THR, WA HEA R
WP 75 10 hex SCAF, IXFERANREGRSLIAT N — 2. H P ERIZ IR SOERE T2 )G,
13



TEHHIE, HEGIFREE RIHR,

§3.413 4afE (BEE)

2 “Output” % I “Build” TR EFERINZ G, il B4 T AW 1) hex XA .
BER P R AR AR B e BRBEERART H AR O R BT g RE, AERRER T B RO
[FJCONFIG - B LA M2 G i X 3

WG AE L FE R I “ ConfigX A5G 2RI (F4E7R, TR E O IMCLR LB o an S8R
IR BRI b=, s W 28 .

§ 3.4.2 1247 M A

FEGMFR D 2 FH P sl il LA TR T ICD24R AL T 2 Fiig 47 Ak T B, i &g X
eE AT PR TF BT DA LGB (B R SE R P IO RE,  JF R I A7 7 A B B A 2

§3.4.2.1i47 2

o T HA: RS ERR I A2 247, 1ICD2I24T 1770

“Run” : 3fiaAT, s ratfE s s 7 W sk &5 k. X AT )7 0] BLE Y
WL BIFE 7 s TR, JF AR AR L) R

“Halt” : 5103847, EER, HTICD2El i H Flash T 05 16 H 4 f Th E K S
RINBENT, EPATHINAEN, AR H CLLbrfE 1l T84, 1 AT S TR 1
DIRE T o BERn R T EGE TS EBUS R BICD2 LN M k4R Tl a4 158, WA - 752
AT “EESEEE” .

“Step Into” : HULPAT. M D IIRETT L S22 Y 5iiE A PAT IR . R 2L 1)
Ae T LASCIL 2 R H i, lan, o DU I RESR W FE T 00 SOk T n), B0 FH SR WL E%
B . BH%,

“Step Over” : BRED, fi XA ThAENT RGO Bk R 00 A2, B R aT 210
MR —iE6]), XA /e 3] “CALL” W& A) I nl LA XA Shae BaE 2R MEE R T . |
WHZAEF) W S WA BT T IR I TR, R4 A8 F b Th RE ik vT LLIgE 66 fa N oD 0T
JOUBA TR A R IR (1) JBR T

“Reset” : S &AL, X FILGmiERE PR UL, PATILIIREEREFPCHEIR Mt B IR = AT
otk X FCHESIEFEFRUL, AT LTI EE G R PCI /L 48 7 main() R AL 17 Huhk

§3.4.22 Wi EkE

Wr s ThRE S 7E R P W A H B TIRE, X I REAL 5 F 7E IS AT A N [0 AR 715 A I 1k
k. FERRPISAT BIWT RS R O I, FH AT DR S H FRAR RS AT 1 LB A OSRAMIFII >k
SIHTIBAT IS L o

ICD2 L REFEAIE— AN i

§ 3.4.2.3M FAF BRI E

BT IR RS, P TR S TR B — Lo A7 2 0. D TAEH 7 (8, wride
— R AR N A A A W E WS AR R . T SRR A View->Watch R T W B, REHK
S —A> “Watch” (WA R) & H. WEI4F7R,

mwach —loix
Add SEHl IADEDND vI add IEDUNT j
Address I Symbol Name | Value |
001F ADCONO Ox00
ooz COUNT 0x00

['watch1 watch2| Watch3| watch4|
Bl 14 WA e i 1

FETI IR “Add SFR” %L 1K) F S b s (RS R R A7 g (A4 AR, P ] AR iz
SHHIEBOFE “ Add SFR” #2815 ZENEE IR IR ZF Ar a s I B AR R 3R b [,
P ATELAE “ Add Symbol” 4% HLS ) 3 o B A e SRR S, IR AT AL AR i b 5
EYIELIPYIE 25w IR L

T ETTAE, P IE ] A WA A ) “Watchl” ~ “Watch4” 447 % L1y
RIS AR 5
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ICD2$ I T 2 Fh AR B 22 55X, FH P af AT AL HE F P B AT 80 e oW 2 A48 & DLl FH A7
fitigs FEIPAAERS . TOEHERRAMIEEPROMASE % 11 o A =231 “View” JEII AT LT 8k ¢ A
IXEEET I,

§ 3.5 PRI B 45 1

MPLAB ICD2 IR D e s br b2 it 755 h v 5 N —BUR R P RSB o 05 il i ix
AR R PAT EALHLAR A, IS T8 FR M 3 A7 L. P AE A FHICD2 3 AT 3K
HSeR G4, AR R T B A B D RE A R AR 75 B S R R . AR RRAT]
T e R R RIS, PRGNS DLTE S5 MPLAB-IDEH [ICD2 3 B S0 F

§ 3.5.1 KT B PR il

ICD2 AR T B BR ) 3 Z LLU R LA

1D P B BEE — AN T

2) A D ANREM N W o T AR A BRI, ICD2ZEFAT H 20 B AN BE Bk % 21 I A\
4k,
3) MRV I HERR, (HEA ARSI AR
4) MPLAB-IDEIRZA: A 7R I B 5 S bR P Al o oG o LI B /& iy FH P Al B 1)
PG TSP B 1Y, IDEASREIEH RIS

5) BRGSO P 2 5 B TR 5 A0 T B R e o B T R AR .

§ 3.5.2 {fi EL W T ¥ PR A

ICD2f{)i EIhHE M BR il 5 2 LR JL s

1D PRI ASGE A FISLEEPYE 4>, tH At /& 1 o2 B MR (1) 15 400

2) WA HWDT,

3) PRRRANGETF I 5 RIS AR CRBERE SR AL ©

4) PRI ASBETF B R S 5

§ 3.5.3 JLFFS H I 2k PR i)

PIC12F629/675. PIC16F630/676:

1) ZBAE FH A 3% B AR I5 %% 5

2) MCLR IS AL = S s

3) M GP1/RALN & P I TE v AT

4) ANREFEXT GPIOEAE 45 4 b s B W s,

PIC18FXXX:

1) BE RE e DGR 4 i bk DA 252 MOOH E T 46 BR8N FE AT — AL AR P BRI 238 —AT
2 o Rk 05 25 OO I T U6 AR AR S N FE AT A — 2 IR R B () 45 2 o W ke s st bk vl DL
0x10, TMAREAZ0x12; & bt n] UEOX 1R A fE /2 0x14 .

2) X FPICXX20, AVDD FIAVSSH|AZiss |

§ 3.5.4 T HIME Ui

MPLAB ICD2 7 H s i 8 5 an F

D HHMCLRG |, DL A B AT G (140 B S 25k D 5

2) b 2 HEA

3) HH T ESFEFEX MRAM (FEILICD2F B Sch) .

BRI T B AN S PR A A O (BRI MR, ERENA R,
5 | B0 150 B B R A HE A T R R

EIIEFHICD2EN S 28

§ 4.1 ICD2f{ ke 5 BEE
§4L1IEFEE
B, M HEEEEREE S CAERSE R KRR G2 A ), st
S Hf)Configure->Select Device, {EREFEL v 85 & 11T Hr 3 B B P8 7 K S B .
TEFE T AN O 2 05 P s AR 80 v 5 % L1 “Microchip Programmer Tool Support”
HE HL 7 B Microchipke 5 T H X %0 H X FEf L. o
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1 2R T H HATEA SR /0 s

2) SRR L H AT PUSCRR 18 s

3) B R NI T H H TR S Fres v i SR A AR MR A

RSN el 5 2 5 midh “OK” #iik.
§4.1.2 BE T HIEM

§4.1.2.1 ikHF T HARM

WURH Pk FRICD24E A ke S TR, AT EAEMPLAB IDEHF TR & . middi TR
Programmer->Select Programmer, i%$#:AMPLAB ICD2.

XN RGUF R
Connecting to MPLAB ICD 2
ICD0019: Failed to open communications: Non—existent port
ICD0021: Unable to connect with MPLAB ICD 2ICD0021: Unable to connect with MPLAB ICD 2
MPLAB ICD 2 Ready

XS FH T MPLABBR I 3@ tH 75 O USB, 158 H 5 I Ky comt I, ik LT o

MR TN G, RGBSR EICD2HIERE I IR EE7R “ Target Device **** found”
MWa—Y)ER; WHREER “ICDWarn0020:Invaild target device id . . 7 A4 1 A FELJE ¥ B LA 6
SRR IE RS DL

§ 4.1.2.2 BB i FEk I

7t “MPLAB ICD 2 Settings” % I HLEF¢ “Program” KB E AN IR FEIET . B E 5 ikik
SN BCE ML, SR SEUG R TOTI N FE R R A BE

§4.123 HJFIKE

7E “MPLAB ICD 2 Settings” 7 [T HLIE ¢ “Power” KULEFINIEIN, LEAE Ky S FLge i 7 i
FH 25 “Power target circuit from MPLAB ICD2”  (JAICD24IL e i [ ) 2) 3% I .

{fiH “Update” F25 ] DLk~ 5 H§r H st Ervdd. Vpp A& ERHLER LIRS B R 1
o

WESEHUG mdT T N7 F R R AR B

§4.1.24 THFR

F P& nf LLfE “MPLAB ICD 2 Settings” i 1[I T fif 215855 4 #s JLAMAH 115 8 -

a) “Status” FH: SRR, PRI F BT FT

b) “Warning” F:H: BIREEEE, H AT RIEXAME H By & 4T A G 545

c) “Limitation” #%H: MIXHEH ] LLT A B ICD2 (1) —LE {5 FH FR il 5

d) “Versions” #F:H: WAME R

2 “MPLABICD 2 Settings” % A H B G, W sid “woe” BHwE, W
RGN AP M aT s s Wk Al “MPLABICD 2 Settings” % 147 EJ7 ) “X” SKiB
WE, BagraAR “NH” MEESAPIRLE.
§4.1.3 WE LT CONFIGT

BAE S A e IE B L T AR K P A W B R E A N ) CONFIG &, sl 3 3¢ (1)
Configure->Configuration Bits K ZEATFH N [ 15 &

riily “Setting” F1 5L AR NAE I Z G RS HIL—AS TR, H P o] AR XA SR
ENTbRe N

SN AEA SRR T, BN LPR “Low Voltage Program”  ({IGFE R gmfe) EIICH] .
RIEFETT R TRAIEI, A S SR e & TR ERE S GEEESEZO R
MBS TEED .

R B OB T EEAR A SEBR S OORIE RS, S A AT REJCIE IR TAE.
§ 4.2 FABEE AL ST

TERHMTIRE Z 0T, B e 2R 75 20 5 A S Chex SCA) SN BTN A7

FH P AT DU 32 32 BRI File->Tmport iy 22K 5 N 75 B4 S I hex SO WA 7 A B RE
PAL SO, A4 AT DA ] 32 52 # ) Programmer->Read KA ACIL 152 N N AFH, SR Z 5 AR it
52 R N A 0 15 B CONFIGE 2 Jig B e 5
$4.3 K5I
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AR S 2 G BT BEA T e s, P BT DUSEF =251 “ Programmer” —§- 3¢ i
TSI, Wa] DU T 2L b B b okt A7 A o1 .

APPSR B B IS B AT OO B (1) 32 58 FA g A A

Program: %5 .5 .

Read: iZHCH AN WRBIIS R CERE, AL N RBA S IEAAS,
M — RN E AR GEF 420 .

Verify: FEFXEE. R HEROH OHRE, BB FREE RN .

Erase Part: #[& HAx . $ATHERAERIIG, HEsS B S A SR

Blank Check: H8: Hbx 8514275 4 4 s

VE R 58 5 2 A B I A B T DO S 5 i T e S LR

FINEH LIS

6.1.01. ICDWarn0020:Invaild target device id . .

R I IR T0E 7 I 1 A A <

FH PR 8 2 IR 5

SR 5 TN 8 R

RS 1A B A5 IR T 5
6.1.02. ICDWarn0019: Debug mode is not enabled. .

X IS 7R I A

S5 BN R EAE A 1S RATs

R AR A IR
6.1.1 I): A AT R G AR B 56 2R M ?
2 FRRGES &, SR TR, K EEPGC. PGD AIVPP R DL HLE, 2 WrikhE. B H s
PICmicro # L L. @il H FsPICmicro 54 HLATAVSs FIAVPP 5, A\ I L] JHIHR O 1F A
BUEE 7
6.1.2 : WA AFRFTEICD H4ik?
Z: X TFMPLAB ICD 2 SZRFIAR S I A as A, WRAELR S | IR OR B, B AN REAT Al F X L6 8%
o WA, XF8AFIMIZE, 6 MO SR L3 M. Ak, A5 THERM
A& (bond-out)  PICmicro 5L, X Fh e A LRSI I — AN e e SR FLIX LS | sk, X
5 ae4E B br AR BT 51 . 485 (bond-out) PICmicro ¥ 4 HLEA fEL @G | S
MPLAB ICD 2 #:. XFEMAR AL 7T LUFIMPLAB ICD 2 JF R GG B . B it X Fixet
A E, AMATIEL I, ANe RAEHFRN TR —ANICD 2 3846 e, i ZAEH M5 (bond-out)
PICmicro i #l. iX£e4h4 (bond-out) PICmicro H. IR T B2 5 1, fescdr 2 phaett.
TEICD 4k AR EABRERBLE S, LS IR 2R AEAHUC RS . X SOk | s fF ] e ik
A FEENC RS, AL BAR N _FCE —/NCD 2 i i pe e i Le g F i vep. PGC FIPGD,
KK HIMPLAB ICD 2 %ift.
6.1.3 [il: JCIEEREFIMPLAB ICD 2 . FRILAEiZ/E Af?
%:: MPLAB ICD 2 (JHEJE] 72 T8 ? IXALED MiZeHram. Wi e thigm:, nlfe HiEH: TUSB,
Pl RET BB — AN, PC IRS-232 IANRE AMPLAB ICD 2 $2 At iy, AituSB ]
PLo EEALUSB R4 N Rede b iy, THEMR AT LR, AR EL D). USB IK) @ ir
fin 2 {fEWindows £ B3R XU HE HH B 1% A] LU FIMPLAB ICD 2 [USB k5. —45USB 42k 4%
ANREAEREIUSB eI . (IR LR LR 2SR, R ZAEMPLAB ICD 2 E#:—AHE.
6.1.4 [7]: ICD 2 Wi/ “Target not in debug modeerror. ” X &4 & 2
% WEIXULIMPLAB ICD 2 ARERTHAPAT R . N gl % $Debugger>Program > #,
X P R ) H ARPICmicro e L, >k N EGIRHATREE P . o] B H e St A4S 38
PATHE P AGEIE W, a1 H AR BhEl iy i . A B RCE N, itk “Background Debug” ffifE. &
Config>Configuration Bits..., iR 1R 2E L, ARG, IF HARG 4 W E IR .
6.1.5 [1]: MPLAB ICD 2 Befl—AMEHL KB 1T 1 H AR — i TAE?
% M. HEHFRPICmicro L HISCRHMIKHE RIS 1T, ‘EathefEVop IRB L2V M5 Figir. 1k
MPLAB ICD 2 [#)%i N/ iy th 22 ph s A7 fi P4 o IR 28 N/ B th 22 o 2l o H AR AR
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VoD i, 5348, MPLAB ICD 2 &G0 H bras 10 TAEE K, IF IEAf R 320 D) 5ok Ab B H
e, R R E A FLASH #5358 . fEMPLAB ICD 2 [f] “Settings” XJififEH, Vob FHikFEN
“From Target” , JfH7EHFst EZA—AREH T RIETT.

6.1.6 1]: MPLAB ICD 2 K Lgufe (LVP ) H5?

B AF HIXFFAK IR M ARSI T AL VoD I, MPLAB ICD 2 ANREIEH TAF. Rk
ANHEINEIVPP _F ¥ g R N S8 +12V

6.1.7 I1): NP AR EHAIA (PLL ) PRGN HE? MPLAB ICD 2 # 4.
% IXJEPICmIcro H HLETE SR . ZEXTPLL 353 2% I EL B A g Fe o, FRLYR 5 BT 4% I F i 21 B
FRBR Lo WHREA IR, HARPICmIicro B HUK A el S ke, R AR BE TR, [
FE, WERAEDIHBIPLL A, Ry g i, ST RESIEYT, (B HPLL.
6.1.8 In): HIRZEARNLILEN, WA ALARIKS), R S IRAELE RS AR b B B e,
I HIRAEIR S 10 SRR ) T IEAA SR AT?

B XA A DU R R B HIRE e, TR AL “Add New Hardware (7R il
gL 7 . EREHRIE)G, %8 “No, the device isn'tin the list.” , 2R/GEF “No, |
want to select the hardware from alist.” , Fi%$¢ “UniversalSerial Bus Controller,” . 24 H 31 “Have
Disk...” $ZHIF, HENIRE)SCIEIE, FFE B IEah M oRE) .

6.1.9 ]: FRALFHMPLAB ICD 2 SZERACAL {40 2

2 Afg. fCRELRY, RENEREFAF it AT X IR R S Wi MPLAB ICD 2 1E % TAE. 4
i FIMPLAB ICD 2 ik, NEAf AT U (R sl 3 e AR P O B W . e S S F AT
RIS, B EMPLAB ICD 2, A] LUE fEfCiD R4 .

6.1.10 [i]: MPLAB ICD 2 ] &b F A v i ds 2

%o EHBNCHE . R SRR, RS thPICmicro FUA WL TR HERE AT AT
{H#SHEMPLAB ICD 2 3 H - RAF . AT EAAME R AR X Se 5 .

6.1.11 0. A AFRMILHIEEDATA X N153 T 5= r{E ?

%: MPLAB ICD 2 REH#% 1 HLEEDATA XI5k, AT 2ZEIMATEECON 77 /745 ZLK I TABLRD fi54
J¥%1. MPLAB {f FH M ZZ ph s A7 I 2 T P 0ARES  MBDHATARRD I, Y 38 S 26 R 1 1 5 F
MPLAB ICD 2 ZEEDATA [X 3.2 ]2k [A]47) 4z .

6.1.12 [7]: KfF4 “Erase All Before Programming ” K$i 7T ?

Zeo AESUROBTIFLASH 234 h,  gn RS Bk ARARUL KRR A7 2 X ik f4cbank ZmfE. Xt Fixds
BN, AEGFEZ T A T AT A 28 o

6.1.13 I1):  FRMIFEFREANRELE A THEMPLAB ICD 2 (15t F, MPort B 8{# GPIO i
T E?

By Sl UELIRII e REN, PGC MPGD & #MPLABICD 2 £ /1], Jf HMPORT B #47
FE M PSS E T . 1 MPGC FIPGD 3 H B A& IE#R, T HL S BEX A5 1
SN FiAkh, WitkPort B HCFARL R IR AT E,  PGC FIPGD _F ¥ 5 ¥ A RE ™2 I o

6.1.14 In):  HUDHATHS, @S T ABITAIER?

% KRG IR ES 2 —. BT SERs FR R PATR P IEAT, ERRPITR T
BATHINL, B P N R b, e S A R SRIE AT

6.1.15 |a: {EffiHPIC12F629/675 B PIC16F630/676 I, At 4oAq e ik ki ?

2 LR FIMPLAB ICD 2 il frf, ix 26 284 (G PL/RAL 5| AN Re bk 47 57 - 2 WWMPLAB ICD 2 Header
(DS51292) (Y, FRIGFHE LK T XX LB FEHICD 2 HIfE

6.1.16 In): AT AT AT (S LED NR?

% XAREFR IR H AR _-MPLAB ICD 2 MR FE LR ITUT I T (R RM D o KTINRE R i
T KH, MPLABICD 2 [IEAESGH o NI FIMAZE I H As 2607 5 T« « AR N AR Power
HMiBusy {5 *FLED (HLJEAREHCIKT 7D o o $iAT—IK “Self Test” , &4k “MCLR=VPP” L[¥)/Mi
WA MR e ST o o AH HERR A PLGBGARIEYE ], BAT— R, 5L
(VPP) 7-8V IHL T RAC T o MR, W HBAIELNUTAH R,  MPLAB ICD 2 H1 R S &
B 1R BB R o« 24 HASBOERIELRINT, A LLE BIHOE s,

6.1.17 i1]: MPLAB ICD 2 H1{#) “Self Test ” A A1EH?

& “Self Test” 1441 H BI T H#i 2 MPLAB ICD 2 #itkal, H brARIERE A 4 8. H45VDD, 1 Ri%$#: T “Power
from ICD2” , NIMIXEMPLAB ICD 2 $#2{:fvDD (X5 V) . WIRES T “Power from target” , T
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HFsIRIEAEIVDD (2 £6V) . Pass/Fail ith: fiiR#&/"fEAdvanced X[ iFHEH “Power” & A IEM, Bi#H H
FEBIVOD 1R T/ AR T RUE . HdvPP

DR AE AL FE H HMPLAB ICD 2 $241L45 B FsfVPP/IMCLR Bl ZwFEE . (VPP) &

Pass/Fail ih: IR B B FRRVPP/MCLR 51 HE A TE# .

MCLR=Gnd

MIEXMPLAB ICD 2 8 AL HARE L, R4 A-F45 HARVPPIMCLR 51 8

Pass/Fail i5: U IREHVPP/MCLR 5| B2 ANIE#i. 00 = Pass VDD 735 € 1138 01 = Min error VDD
%F45 7€ K75 180 = Max error VDD & T-15 7€ {178 [E00 = Pass VPP 7E35 & (75 401 = Min error VPP (X T-1R
SE M35 80 = Max error VPP = T4 2 L 00 = Pass i #>F m) IRt 4 H ArVPP/IMCLR 5180 = Max error
Hu eS0T H ARVPP/IMCLR B K =

MCLR=VDD

PWRIEH TA/E (o ‘Run’ ) WA,  MPLAB ICD 2 #24/tVDD 25 H kxVPP/MCLR 3 #ITIGE 1. Pass/Fail -
P IR L WI7EAdvanced WHTHE “Power” S E AR IER, B0 HARKIVOD BT/ (KT E(H. MCLR=VPP
WA 7R g A T MPLAB ICD 2 $24:VPP %45 HARVPPIMCLR BN BE S Pass/Fail i%:  H A %201
VPP/MCLR 54 AN IEH#f o

6.1.18 [n): HIIRETFIE 54 kM H S h by, Jft4Aw . STATUS FIBSR %
a0 ?

% AT aRe P Wi FICALL FAST IR T W A7 45 $MPLABICD 2 {i /] 7. X442 (R4 MPLAB
ICD 2 #RAEMYs. an SLbr i % B fECALL FAST FHREFIN, B 76l RETURN FAST S{RETFIE
B T R A e e goh Wi 25 N, R LR . 00 = Pass VDD #2445 H bx
VPP/MCLR 5|01 = Min error VDD %} T H #:VPP/MCLR 5|80 = Max error VDD %} H ##VPP/MCLR
S K500 = Pass VPP A #AL45 H ARVPP/MCLR 3 1J101 = Min error VPP X T H FRVPP/MCLR 5 JHIKAE
80 = Max error VPP %} T- H #RVPP/MCLR 5| K &

6.1.19 In): HIRAEFEFIRIGA B R E — WS, Ataeisibesihkoool , A
& 4-0000 ?

%: MPLAB ICD 2 7EWT s JG MR A L85 . IXRMAE W B T W s #0000 Ab 145 4 S 8T,
B YT RPN U, PR A RS TR M HE0001 . 40 B i AR AL R A 4 4R A b T
12, A AT 120 7F HiHE0000 4b4 A—4<NOP 54 .

6.1.20 [v]: AT AR UEAEAE 2% 57 AR PR IRE 2

% : MPLAB IDE 1E7E WoRBRIN AP A e . B oRasth EIsSEpr(E, L2 HMPLAB ICD 2 #17
— IR AR

6.1.21 [n]: HUDPATACRINS, FRITEN ST, H A4 T a2 i 25 o W AR 5 72 -
HIAT?

2 FOLPATIN, EL RS A L VFPICmicro 5L AL N K. dn S ASVFIGEE, 2 P A A B
N, FRA S RAT R LT B S AE R W IR SRR 4 . TR T, SR P R4S AR P R T
FEIBAT, XA A T I BT 28T A

HERR

BEREFPETFERERAA

kb PRI T 8 S AR T Ay 3 66
Hi%: 025—86957890 86074937

fEHL: 025—86957890

P3k: http://www. elc—mcu. com

E-mail: service@elc—mcu. com (FHA) sale@elc-mcu. com (§§%)
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